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PowerPoint 2010: Basics 
Learning Guide 
 

 

 What’s a PowerPoint Slide? 
 

 
 

PowerPoint presentations are composed of slides, just like conventional 

presentations.  Like a 35mm film-based slide, each PowerPoint slide 

presents one full screen of information to audience members, meeting 

attendees, or course participants, and: 

 can be edited easily 

 can incorporate text and images from other documents 

 can utilize animation effects 

 can be easily stored, shared, and reused 

 

PowerPoint slides can be displayed directly from your computer or they 

can be printed to more conventional media.  You can print full-page 

PowerPoint slides or multiple miniature slides on each page.  Slides can 

also be shared on the web in various formats, or can also be printed to 

overhead transparencies or 35mm film. 

 
 

 



 2   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 

The PowerPoint Window 
PowerPoint 2010 allows you to compose and edit slides, navigate through 

your presentation, and draft speaker notes without changing views or 

opening additional windows. 

 

 
 

 

 

 The File tab launches the Microsoft Office Backstage View.  The 

Office Backstage view is where you manage your files and the data 

about them – creating, saving, printing, inspecting the file properties 

information, and setting options. 

 Each menu bar tab is task oriented and opens a Ribbon that is divided 

into subtasks. 

 The slide tab allows you to view miniature versions (called 

thumbnails) of the slides you have already created in your 

presentation.  Each slide is numbered in the order that it appears in the 

presentation. 

 The slide pane is the area in which slides can be created and existing 

slides can be edited. 

 The notes pane allows you to enter speaker notes that complement the 

content on each slide.  These notes do not appear on the screen when 

the slides are shown in full-screen mode.  However, you can print 

notes along with your slides to create a set of note pages to which you 

can refer during your presentation. 

 The status bar contains view options that were previously located on 

the bottom left of the slide tab. These options, which are now located 

on the right-hand side of the page, allow you to zoom in and out of 

your slides, and use different viewing formats.  

Slide tab 

Menu bar tabs 

 

Ribbon 

 

 

 

 

 

 

 

Slide pane 

 

 

 

 

 

 

 

Notes pane 

Status bar 

File Tab (Backstage View) 
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 Exploring PowerPoint 
At first glance, the new PowerPoint 2010 interface may seem a bit 

unsettling, with “fat bands” called Ribbons replacing cascading text 

menus and task bars. This guide will help put you at ease as it introduces 

you to the new design and explains the new nomenclature. 

  

What’s New in PowerPoint 2010 
 Microsoft Office Backstage View – new file menu which offers 

commands whose functionality affect your whole PowerPoint 

presentation (for example: saving, opening, closing, printing)  
 Customize Ribbon – allows you to add custom groups to the existing 

tabs on the Ribbon and then add frequently used commands to the 

custom groups. 
 Dynamic Paste with Live Preview – new paste feature with new 

options that allow you to preview the effects by simply hovering over 

each option (for example: Use Destination Theme, Keep source 

Formatting, Picture, Keep Text Only). 
 Screen Capture – caches screen shots of currently open windows for 

easy insertion or a screen clipping where you select a portion of the 

window to copy. 
 Remove Background – new tool for pictures and graphics, allows you 

the remove the background of an image without the need of an 

external image editing program. 
 Enhanced Media Capture and Editing – most notable changes to 

PowerPoint 2010 involve media capture and editing.  PowerPoint 2010 

offers built-in basic audio and video editing tools, including the ability 

to trim video and audio from within PowerPoint without the need of an 

external editing program. 
 Embed Audio – audio files of any format can now be embedded (for 

example: WAV, MP3, MIDI, WMA, MP4, MP4A). 
 Embed Video – video files of any format can now be embedded (for 

example: WMV, MOV, MPG, AVI, MPEG). 
 Insert Online Video – insert video from online websites such as 

YouTube (note: must have active internet connection). 
 New SmartArt Templates – new and improved SmartArt Graphics 

and diagrams. 
 Animations and Transitions – new and improved transition effects 

(for example: Reveal, Flash, Ripple, Honeycomb, Glitter, Vortex) 
 Themes – new themes, color sets, font sets. 
 Equation Editor – updated and improved, now utilize the same 

version as Microsoft Word. 
 Built-in PDF Writer – Office 2010 includes a native PDF writer to 

help you save documents in the PDF format without the need of a 

separate PDF application. 
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File Tab (Backstage View) 

The File tab, located at the top left corner of your screen, replaces the 

Office Button and File menu found in earlier versions of PowerPoint.  The 

File tab allows you to carry out functions such as opening, saving, and 

printing your document. 
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Ribbons 

Located where taskbars used to be, ribbons graphically display the 

changing features as you click on the menu bar tabs. It may take you time 

to adjust to the new locations of familiar options, but ribbons may also 

expose you to useful new tools and commands. The image and table 

shown below will help familiarize you with the various options. 

 

 
 
The Ribbon… Allows you to… 

File Carry out functions such as opening, saving, and 

printing your document 

Home Change the Font, Paragraph and Heading styles and 

view the clipboard and editing options 

Insert Insert pages, tables, illustrations, links, headers, 
footers, text and symbols 

Designs Change page layout, choose slide themes, colors, 

fonts and effects, as well as background styles and 
graphics 

Transitions Set visual movements as one slide changes to 

another 

Animations Set visual effects to individual items on the slide such 

as graphics, titles or bullet points 

Slide Show View entire presentation, rehearse timings, and 
change monitor settings for the slide show 

Review Use proofing techniques, insert comments, track 

changes, compare and protect documents 

View Change document and window layout, show/hide 

thumbnails, and view/record macros 

Add-Ins Customize toolbars 

 

 

Hiding and Redisplaying Ribbons 

If you wish to have more room while working, you can hide the contents 

of the ribbons: To hide the ribbons: 

 Double-click on one of the menu-bar tabs (it does not matter which 

one). 

 To redisplay the contents of the ribbons, double-click on a menu-bar 

tab again. 
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 Customizing Ribbons 

With Office 2010, you can now customize the tabs on the Ribbon to 

display buttons of common tasks and commands that are used frequently 

used in each application allowing easy access – like save, undo, copy, 

paste, and print.  To customize the Ribbon: 

 Click on the File tab, and then click on Options 

 

 
 

 In the Options dialog box, click Customize Ribbon 

 Click on New Tab near the bottom of the dialog box. 

 

 
 

 In the Choose commands from list, select your commands from the 

default list of Popular Commands, or click on the down to select from 

all commands. 

 With your commands selected, add each command to your new tab by 

clicking Add. 

 With your tab select, click Rename near the bottom of the dialog box.  

In the Display name box, type the name that you want for your tab. 

 

 

 

1. 

2. 

3. 

4. 

5. 
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 Click OK to update all your changes. 

 

 
 

 

 The newly created ribbon with the new commands will now appear on 

the menu. 

 

 

 
 

 

 

Tip: Positioning Your Tabs and Commands 

Use the up and down arrows next to the list of tabs to position your 

commands and tabs.  Select a command to move it on your tab, or select 

your tab to position it anywhere on the ribbon. 

 

 

Dynamic Paste Preview 

PowerPoint 2010 has updated its frequently used Paste command with 

additional options and functionalities.  You can now preview paste effects 

with ease by simply hovering over each option. 

 

 In the slide pane of the PowerPoint window, select the slide onto 

which you wish to paste 

 Right click on your slide 
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 Under Paste Options, place your mouse over each selection to 

preview the effects. 

 

 
 

 Left Click on the option that meets your needs to complete pasting. 

 

 

The Quick Access Toolbar 

The Quick Access toolbar, located directly on top of the File tab, contains 

the three most frequently used buttons: Save, Undo, and Redo.   

 

 
 

You can customize the Quick Access toolbar and add any button that you 

frequently use.  To add a button to the Quick Access toolbar: 

 Right click on the button you wish to add (for example, Cut). 

 From the drop-down menu that appears, select Add to Quick Access 

Toolbar. 

 

 
 

 The button will now appear on the Quick Access toolbar. 
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Developing a New Presentation 
Creating a New Presentation with Design Themes 

PowerPoint features an extensive selection of design themes, each of 

which includes background graphics, custom slide layouts, and font 

formatting for various types of slides.  These theme templates make it easy 

to quickly create and use a new presentation. To create a new presentation 

from a pre-set design theme: 

 Click on the new File tab and choose New. 

 A New Presentation window will appear, with Blank Presentation 

highlighted. 

 Click Create on the right side of the window and your new blank 

presentation will appear. 

 Click on the Design menu bar tab to expose the design ribbon. 

 

 
 

 Now you may browse the Themes section and select the theme you 

prefer. On the right, you may scroll down to see additional themes. 

 Select a specific theme by clicking on it once. 

 

 
 

 

Tip: Automatic Theme Preview 

To see how a specific theme will look with your presentation, simply hold  

the cursor over that theme (do not click), and a preview will appear. When 

you move the cursor away from the themes, your presentation will revert  

back to the way it was before. 
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Changing a Slide Layout  

After you have selected a design template for your presentation, you can 

use slide layouts to create new slides which will hold the content for your 

presentation. 

 In the slide pane of the PowerPoint window, display the slide whose 

layout you would like to change. 

 Click on the Home menu bar tab to expose the ribbon. 

 From the Slides section, select the Layout button. 

 From the drop-down menu that appears, select the layout you desire. 

 

 
  

 

Tip: Default Layout 

PowerPoint will automatically use the “Title Slide” layout for the first 

slide in your presentation, and the “Title and Content” layout for each 

consecutive slide. Use this technique if you wish to change the default 

layouts. 
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Inserting Text on a New Slide 

Once you have selected a layout for your slide, you can start adding 

content.  Many of the slide layouts provide text and image boxes to make 

this process simpler. 

 To insert text into an existing text box, click in the box so that a 

flashing vertical insertion point cursor can be seen. 

 Once you can see the insertion point, you can enter, edit, and delete 

text within the box is as if it were a Word document. 

 When you have finished composing text, click anywhere outside the 

text box to deselect it. 
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Creating Additional Slides 

PowerPoint 2007 allows you to add additional slides directly from the 

Home ribbon. 

 In the Slides section of the Home ribbon, you will find the New Slide 

button. 

 Click once on the top portion of the New Slide button and a blank 

slide with the default layout will automatically be inserted. 

 

 
 

 Clicking once on the bottom portion of the New Slide button will open 

a drop-down menu which allows you to select the layout for your new 

slide. 

 Select the layout you desire by clicking on it once. 

 

 
 

 

Tip: New Slide Location 

In either case, your new slide will be inserted after the slide that is 

currently being displayed in the slide pane. 
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Designing & Customizing Slides 
Although PowerPoint’s templates and slide layouts are powerful tools for 

creating effective presentations, you can also customize the content on 

each slide. 

 

Selecting Text in a Text Box 

Before you can format the text inside a text box, you must select the box 

and its contents. 

 Click on any of the text within your text box.   

 The box’s grey dashed border and circular/square handles will become 

visible around the text. 

 To select text in the box, drag the cursor to highlight the text you wish 

to format. 

 

 
 

 To select all of the text in the text box, click on the box’s grey dashed 

border. The dashed border will become a solid grey border, and the 

handles will turn light blue, indicating that you have successfully 

selected the entire contents of the text box. 

 

 
 

 

Formatting Text in a Text Box 

Once you have selected the text that you wish to format: 

 In the Home ribbon, the Font section allows you to use one or more of 

the following buttons. 

 

If you want to… Click on… 

Change the font of the selected text 
 

Change the size of the selected text 
 

Bold the selected text  

Italicize the selected text  

Underline the selected text  
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Changing the Text Color 

 Select the text you wish to format. 

 Locate the Font section of the Home ribbon. 

 

 
 

 Click on the down-facing arrow to the right of the Font Color button. 

 From the window of font colors that appears, select the color you want 

to apply.  

 

 
 

 

 

Aligning text in a text box 

Once you have selected the text that you wish to align: 

 In the Home ribbon, the Paragraph section allows you to use one or 

more of the buttons below. Only the text inside the selected text box 

will be affected by using one of the following buttons. 

 

If you want to… Click on …  

Align selected text on the left  

Center the selected text 
 

Align selected text on the right  
Justify the text  

 

Tip: Accessing Formatting Buttons 

You may also access the buttons for formatting and aligning text by simply 

right clicking after you select the desired text. The usual menu  

options will appear and along with them, a small toolbox with all of the  

aforementioned buttons will appear as well. (This toolbox may also  

appear automatically after you select the text. Feel free to use it!) 
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Creating a New Text Box 

Adding a new text box to a slide allows you to place text on the slide that 

may not fit into an existing text box or that may look best in a special 

position on the slide.  To create a new text box: 

 From the Insert ribbon, select the Text Box button located in the Text 

section.   

 

 
 

 Move your cursor to the location on your slide where you wish to 

place the new text box. 

 Click the cursor and move horizontally to create a one-line text box of 

desired width. 

 Enter your new text in the box.  Notice that the box will expand 

vertically to fit the text that you type. 

 When you have finished entering text into the new box, click 

anywhere on the slide to deselect the box you just created. 
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Moving a Text Box to a New Location 

 Click on the text box you wish to move. 

 Place your cursor over the dashed border of the box so that a four-

arrow cursor appears. 

 Drag the box to its new location on your slide. 

 

      
 

 

Resizing a text box 

 Click on the text box you wish to resize. 

 Place your cursor over one of the circular white handles in the corners 

so that a double-arrow cursor appears. 

 Drag a handle to resize the text box.   

 

      
 

 

Tip: Text Rearrangement 

Because the amount of text that will fit on each line determines how the 

text in your box will appear, any changes you make to the size of your box 

will cause the text within it to be rearranged. 

 

 

Rotating text boxes 

 Click on the text box you wish to rotate. 

 Place your cursor over the green circle above the image so that the 

circular-arrow cursor is displayed. 

 While holding down the left cursor button, drag the cursor to rotate the 

text box to its new position. 
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Deleting a text box 

 Click on the text box you wish to delete. 

 Click on the box’s hatched border to ensure that the box itself is 

selected and not any text inside it. 

 Press the delete key on your keyboard. 

 

 

 

Adding Borders and Fill Color 
Adding a Border to a Text Box 

 Select the text box you wish to add a border to by double-clicking on 

its dashed border. 

 
 

 A new Format ribbon will then appear. 

 

 
 

 In the Shape Styles section, click on the down-facing arrow located 

next to the Shape Outline button. 

 From the drop-down menu that appears, you may select the color, 

weight, and style of the desired outline for the text box. Repeat this 

step to make multiple selections. 
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Applying a Background Color to a Text Box 

 Select the text box you wish to add a border to by double-clicking on 

its dashed border. 

 

 
 

 In the Shape Styles section of the Format ribbon that appears, click 

on the downward-facing arrow next to the Shape Fill button. 

 From the drop-down menu that appears, you may select the color, 

gradient, or texture with which you would like to fill in the text box 

background. 
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Applying a Background Color to an Entire Slide 

 Right-click ok on the slide that is outside any text box. 

 From the menu that appears, select Format Background. 

 

 
 

 The Format Background window will appear and allow you to select 

the color, gradient, texture, and transparency of the slide background. 

 

 
 

 Click on the button labeled Close in order to apply the chosen 

background to the current slide only. 

 You may click Apply to All if you would like to apply the chosen 

background to every slide in your presentation. 
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Inserting Saved Images 

You will often acquire images from the web or other sources to include in 

your PowerPoint presentation. To insert an image from your hard drive or 

network drive onto a slide: 

 In the slide pane of the PowerPoint window, select the slide onto 

which you wish to insert the image. 

 From the Insert ribbon, click once on Picture. 

 

 
 

 From the Insert Picture window that appears, navigate to the folder or 

drive in which your image file is saved. 

 Click on your image file to select it. 

 Click on the button labeled Insert.   

 

 
 

 The image will then be inserted onto your slide. It will automatically 

appear in its own box at the center of the slide.  
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Inserting Screenshots 

A new feature in Office 2010 allows you to insert screen shots; it captures 

screen shots of the currently open windows for one-click insert.  To insert 

a screenshot: 

 In the slide pane of the PowerPoint window, select the slide onto 

which you wish to insert the image. 

 From the Insert ribbon, click once on Screenshot. 

 Click on the available screenshots to insert it. 

 

 
 

 

 To insert a custom screen shot, click on Screen Clipping. 
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Removing Backgrounds 

Another new feature introduced in Office 2010 allows you to remove the 

background and other unwanted portions of images and graphics without 

the need of 3
rd

 party image processing applications.  To remove the 

background from an image: 

 In the slide pane of the PowerPoint window, select the slide onto 

which you wish to insert the image. 

 From the Insert ribbon, click once on Picture 

 

 
 

 From the Insert Picture window that appears, navigate to the folder or 

drive in which your image file is saved. 

 Click on your image file to select it. 

 Click on the button labeled Insert. 

 

 
 

 The image will then be inserted onto your slide.  It will automatically 

appear in its own box at the center of the slide 
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 Click on the button labeled Remove Background 

 

 
 

 To accept and keep the default marquee settings for this image, click 

on the Keep All Changes button. 

 

 
 

 Sample result of an image after background removal. 
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Moving an Image 

 Click on the image you wish to move. 

 Place your cursor over the image so that a four-arrow cursor appears. 

 Drag the image to its new location on your slide. 

 

 

Resizing an Image 

 Click on the image you wish to resize. 

 Place your cursor over one of the circular white handles so that a 

double-arrow cursor appears. 

 Drag one of these handles to resize the image.   

 

 

Tips: Image quality after resizing 

 The quality of your resized image will be reduced if you make it too 

large or too small.   

 When you resize an image, use the corner handles so that the image 

retains its proportions and does not appear distorted. 

 

 

Rotating an Image 

 Click on the image you wish to rotate. 

 Place your cursor over the green circle so that the circular-arrow 

cursor appears. 

 While holding down the left cursor button to rotate the image to the 

desired position. 

 

 

Deleting an Image 

 Click on the image you wish to delete. 

 Press the delete key on your keyboard. 
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Inserting Clip Art 

Included with PowerPoint 2007 is a gallery of clip art images that can be 

included in your presentation.  These images are not always of the highest 

quality, but when used selectively they can be a useful part of an effective 

presentation.  To insert a clip art image: 

 In the slide pane of the PowerPoint window, select the slide onto 

which you wish to insert the clip art. 

 On the Insert ribbon, choose Clip Art from the Illustrations section. 

 

 
 

 A Clip Art search box will appear along the right side of the screen. In 

the “Search for:” space, type a general keyword describing the type of 

image you are looking for, then press “Go.” 

 A window may appear asking whether you would like to include 

images available on the Microsoft Office website. Clicking “yes” is 

advisable, as it simply means that a more extensive selection of images 

will be available for your choosing. This message will only pop up 

once. 

 All of the images that match your keyword will appear underneath the 

search box. 

 You may select a desired Clip Art image by simply clicking on it once. 

The image will appear in an active window in the center of your slide. 

This image could also be moved, resized, rotated, or deleted in the 

same way as an image inserted from a file. 
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Inserting Sounds 

In addition to images, you may also add sounds, movies, or other types of 

media to your presentation. While you may develop your own sounds and 

movies, other sound and movie files can be found on the web and utilized 

(with permission) in your presentations.  To insert saved sound files: 

 In the slide pane of the PowerPoint window, select the slide onto 

which you wish to insert the sound file. 

 On the Insert ribbon, choose Audio from the Media Clips section. 

 

 
 

 From the Insert Sound window that appears, navigate to the folder 

that contains your saved sound file.   

 Click on the sound file you wish to insert.  

 Click on the button labeled Insert. 

 

 
 

 A window will appear with the question How do you want the sound 

to start in the slide show? 
o Click on Automatically to play the sound automatically when 

this slide is displayed. 

o Click on When Clicked to initiate the sound manually. 
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 PowerPoint will insert your sound, represented by a tiny loudspeaker 

icon that you can move anywhere on your slide.  

 

 
 

 To play your sound, double click on the speaker icon. 

 

 

Inserting Movies 

PowerPoint 2010 can play several types of media files, including 

QuickTime and AVI movies. You can insert movies using a technique 

similar to the one you use when inserting sounds. 

 In the slide pane of the PowerPoint window, select the slide onto 

which you wish to insert the sound file. 

 On the Insert ribbon, choose Video from the Media Clips section. 

 

 
 

 From the Insert Movie window that appears, navigate to the folder 

that contains your saved movie file.   

 Click on the movie file you wish to insert. 

 Click on the button labeled OK. 
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 A window will appear with the question How do you want the movie 

to start in the slide show? 
o Click on Automatically to play the sound automatically when 

this slide is displayed. 

o Click on When Clicked to initiate the sound manually. 

 PowerPoint will now insert your movie. 

 You may resize or move your movie to another location on your slide. 

 To play your movie, double-click on the movie. 

 

 

Inserting Online Videos 

A new feature in PowerPoint 2010 allows you to insert videos from online  

websites like YouTube.  You can insert online videos using a technique 

similar to the one you use when inserting movies. 

 From the Slide pane of the PowerPoint window, select the slide on 

which you wish to insert the movie file. 

 On the Insert ribbon, click Video with the down facing arrow from 

the Media Clips section. 

 

 

 
 

 

 From the drop down menu that appears, click on Video from Web 

Site. 

 Navigate to an online site (for example: YouTube), copy the embed 

code from the video you wish to insert. 
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 From the Insert Video from Web Site dialog box that appears, copy 

and paste the embed code from your website of choice. 

 

 
 

 Click the button labeled Insert. 

 PowerPoint will now insert your online video. 

 You may resize or move your movie to another location on your slide. 

 To play your video, double-click on the video. 

 

 

 

Note: this video is not embedded in the PowerPoint file.  In order for 

proper playback, you must have an active Internet connection during the 

presentation. 

 

 

Reorganizing a Presentation 
Using the slides tab, you can easily reorganize their order in your 

presentation.  To move a slide from one position to another: 

 Click on the thumbnail of the slide you wish to move. 

 Drag the slide to its new position in your presentation. 
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Tips: Moving slides 

 When you are dragging a slide to its new position, look for the 

horizontal insertion point.  Do not release the button until the 

horizontal insertion point marks the spot in your presentation where 

you wish to move your slide. 

 To select and move several individual slides, hold down the Ctrl key 

on your keyboard when you click to select your slides. Once the slides 

have been selected, drag them to their new location. 

 

Tip: Selecting multiple slides from the slide tab 

To select a range of slides in your presentation: 

 In the slide pane click on the thumbnail of the first slide in the range 

you wish to select. 

 Hold down the Shift key and click on the thumbnail of the last slide in 

the range you wish to select. 

 PowerPoint will select the first slide in your range, the last slide in 

your range, and all the slides in between. 

 

To add individual slides to your selection: 

 In the slide pane select a single slide or a range of slides. 

 Hold the Ctrl key and click on the thumbnail of an additional slide you 

wish to select. 

 PowerPoint will add the new slide to your original selection. 

  Continue holding the Ctrl key and click on the thumbnail of each slide 

you wish to add to your selection. 

 

 

Tips: Using cut and paste to move slides 

You can also use the cut and paste buttons on the standard toolbar to 

move slides from one position to another in your presentation. 

 In the slide pane, select the slide(s) you wish to move. 

 In the Clipboard section of the Home ribbon, click on the Copy button. 

 Click on the slide below which you wish to insert the slide(s) you are 

moving. 

 In the Clipboard section, click on the Paste button. 
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Fixing Mistakes 
For every presentation that you create, you will make at least a few 

mistakes.  PowerPoint 2007 allows you to quickly and easily fix your 

mistakes using the conveniently located Undo and Redo buttons.  

 

Undoing a Mistake 

 From the Quick Access toolbar, locate the Undo button. 

 

 
 

 Click once on the Undo button to undo the most recent action you 

completed.   

 

 
 

 Click on the Undo button again to undo the second most recent action.   

 

 

Redoing an Action  

Do you wish you had not just undone an action?  The Redo button allows 

you to restore the action  

 From the Quick Access toolbar, locate the Redo button. 

 

 
 

 Click once on the Redo button to restore your previous content.  

 

 
 

 

 

Tip: You can only reverse an action immediately after it has been undone.  

Once you make further changes to your document you can no longer redo 

previous actions.  
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Saving Your Presentation 
Most people save their presentation only after they have completed some 

substantial work on it.  If you delay saving, you risk losing your work if 

you encounter computer problems or a power outage.  For best results, you 

should save your document early and often. For example:  

 Save frequently. 

 Be sure you know where you are saving your document. 

 Save whenever you complete a thought, not just when you complete a 

major section of your presentation. 

 Save a backup copy when working on a critical project. 

 

Saving Your Presentation 

 From the File tab, select Save. 
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 The Save As window will appear. 

 Navigate to the location where you wish to save your presentation. 

 In the box labeled File Name, type a descriptive name. 

 Click on the button labeled Save. 

 

 
 

 

 

Saving for Office 2003 Compatibility 

By default, PowerPoint saves your presentation in a format that is 

unreadable by older versions.  To save your presentation for PowerPoint 

2003 compatibility: 

 From the Office Button, select Save. 

 The Save As window will appear. 

 Navigate to the location where you wish to save your presentation. 

 In the box labeled File Name, type a descriptive name. 

 Click on the down-facing arrow located next to the box labeled Save 

as type 

 From the drop-down list that appears, select PowerPoint 97-2003 

Presentation. 

 

 
 

 Click on the button labeled Save. 

 

 

The Save Button 

In addition to the office button, you can use the Save button to save 

changes that you have made to your presentation. 
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 From the Quick Access Toolbar (located to above the File tab), click 

on the Save button. 

 

 
 

 

 

Presenting your Slides 
Starting your slide show 

Now that you have finished creating the slides in your presentation, you 

are ready to view the entire show in sequence.  To view your presentation 

from the beginning: 

 In the Slide Show ribbon, the Start Slide Show section will allow you 

to view your presentation. Choose From Beginning to start your show 

from the beginning. 

 Choose From Current Slide to begin the slide show from the slide 

that is being displayed in the slide pane. 

 

 

 
 

 

Tip: Beginning a slide show from current slide 
A quicker way to begin a slide show from the current slide is by clicking  

the Slide Show button, found on the right side of the status bar at the  

bottom of the screen. 

 

 
 

Tip: Before presenting your slide show to an audience, it may be a good 

idea to run through your show beforehand to make sure that your text and 

graphics are visible and that everything works the way you want it to.  
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Navigating within your Slide Show 

While you are presenting your slides during a lecture or presentation, you 

will often want to move forward and backward among your slides, or to 

display a particular slide.  PowerPoint’s Presentation toolbar can help 

you navigate within your presentation during your slide show. 

 

 Once you begin your slide show, locate the Presentation toolbar in 

the bottom left corner of the slide. 

 

 
 

 To move to the next slide, click on the right facing arrow. 

  

 

       
 

 To return to the previous slide, click on the left facing arrow. 

 

 
 

To navigate to a slide that is not immediately before or after the 

current slide: 

o Click on the presentation menu button. 

o From the Go to Slide submenu, click on the name of the slide 

you wish to display. 
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To end your slide show: 

 Click on the presentation menu button. 

 Select End Show. 

 

 
 

 

Tip: Slide Show navigation 

You can also use the following keyboard buttons to navigate during your 

slide show presentation. 

 

If you want to … Press the … 

Display the next slide 

→ (right-facing arrow) key 
↓ (down facing arrow) key 

Enter key 
Space bar key 

Display the previous slide 
← (left-facing arrow) key 

↑ (up-facing arrow) key  

Return to the normal view Escape button 

Blank the screen B key 

Make the screen white W key 

End your slide show Esc key 
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Making Screen Annotation During your Slides 

During your slide presentation, you may find it useful to emphasize 

content on your slide without turning away from your audience to face the 

classroom screen.  PowerPoint’s Ink annotation tool allows you to do 

this with your cursor, much like using a dry erase marker on an overhead 

projector transparency.  To use this tool: 

 Locate the Presentation toolbar at the bottom left-hand corner of the 

current slide. 

 

 
 

 Click on the ink annotation tool button. 

 

 
 

 From the menu that appears, click on the type of pen you wish to use 

while annotating your slide.   

  

If you want to… Click on… 

Draw a thin line 
 

Draw a thick line 
 

Highlight without 
covering the element  
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 Once you have chosen your drawing tool, place your cursor on the part 

of the slide that you would like to emphasize. 

 Click and drag the cursor to underline, circle, or highlight the element 

on the slide. 

 To return to the arrow when you have finished your annotations, click 

on the ink annotation tool button and click on Arrow. 

 

 
 

 PowerPoint will allow you to save any annotations that you have made 

during your presentation.  To do so: 

o Click on the button labeled Keep from the window that appears 

when you end your slide show. 

 

 
 

o If do not wish to save these annotations, click on the button 

labeled Discard. 
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Tip:  Changing annotation color 

You may want to change the color of your annotations, particularly if the 

default ink color blends into the background of your slide.  To change the 

pen’s color:  

 Click on the ink annotation tool.   

 From the annotation tool’s drop-down menu that appears, select the 

Ink color submenu. 

 

 
 

 From the color palette that appears, click on the square containing the 

color you want to apply to your slide annotations. 

 

  



 40   

Printing Your Presentation 
With Office 2010, the print options dialogs have been completely 

revamped.  You can modify common print settings (for example: printer 

settings, color, slide ranges to print, layout, and collation) by using the 

drop-down menus. The print previews are automatically adjusted to allow 

you to see how your pages will appear before actually printing them.   

 

 

To customize and prepare your slides for printing: 

 Click on the File tab, then click Print 

 

 
 

 Click on the drop down box underneath Settings to customize how the 

slides will be printed (for example: All Slides, Current Slide, Custom 

Range of Slides). 

 

1. 

2. 
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o To print all slides, click on Print All slides. 

 

 
 

o To print only the slide that is currently displayed, click  

on Current Slide. 

 

 
 

o To print specific slides by number, click on Custom Range of 

Slides. 

 

 
 

 

Tip: When you choose to print a Custom Range of Slides, you must enter 

a list of individual slides, a range, or both in order to print.  Use commas 

to separate the numbers, with no space.  For example:  1,4,8-10,12 

 

 

Customizing Print Layout 

To customize the print layout of your presentation: 

 Click on the drop down menu located below the slides input box. 
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 Click through each option to preview the changes on the preview pane. 

o To frame your slides with a thin border around your slides, 

click on Frame Slides 

o To scale the slides to fit paper that you selected for your 

printer, click on Scale to Fit Paper 

o To print your slides with higher resolution, blend transparent 

graphics, and print soft shadows in your print job, click on 

High Quality. 

 

 
 

 

Setting Collation 

To set collation, click on the Collated drop down menu: 

 Click on Collated to print each copy of your presentation one at a 

time. 

 Click Uncollated to print copies of each individual slide. 

 

 
 

Setting Orientation 

To set page orientation for the slides, click on the Orientation drop down 

box: 

 Click on Portrait Orientation or Landscape Orientation. 
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Setting Color 

These options allow the slides to print in color or simply black and white 

to a printer. 

 To print your slides in color to a color printer, click on Color 

 To print your slides in grayscale, click on Grayscale. 

 To print your slides in black and white, click on Pure Black and 

White. 
 

 
 

Edit Header and Footer 

To include or edit headers and footers: 

 click on the Edit Header and Footer link 

 

 
 

 Make your selections in the Header and Footer dialog box. 

 

 
 

 Once you have finalized your customizations, click Print. 
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Getting Help in PowerPoint 
PowerPoint’s Help index is a good resource when you are trying to use an 

unfamiliar feature or starting a new project.  To get help in PowerPoint: 

 Click on the blue question mark, the Microsoft Office PowerPoint 

Help button, located in the upper right corner of the Excel window (or 

just press the F1 key on your keyboard). 

 

 
 

The PowerPoint Help window will appear. 

 

 
 

 Click in the empty search box located next to the blue question mark 

and type a description of the task in PowerPoint about which you 

would like to learn.  

 Click on the button labeled Search. 

 

 
 

 The topics that relate to the task you described will display in the 

PowerPoint Help window.  

 From the list that appears, click one of the topics to display its 

contents.  


